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ATTENTION! This template is intended only for Czech degree programmes and students who write their final theses in English. An integral part of the template is a user manual. The manual describes how to work with this template, how to install it, how to use built-in styles, how to insert figures and tables, and how to generate content. Unauthorized changes in the template make it very easy to disrupt its structure and destroy formatting. Click in this frame and press the DELETE key to remove this warning.
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Examples of the inserted thesis assignment and the author’s declaration.

In the electronic PDF version, which is uploaded to IS/STAG, it is necessary to insert the assignment and declaration without signatures. The original assignment, including signatures, will be inserted into the printed version; the signatures in the declaration will be added later.









Final Thesis Author’s Declaration
I acknowledge that 

· by submitting my final thesis, I consent to it being made available in accordance with the Act No. 111/1998 Coll., as amended, regardless of the outcome of the thesis defence; 
· the final thesis will be stored in electronic form in the university information system;
· one hard copy of the final thesis will be retained and archived by Tomas Bata University in Zlín; 
· my final thesis is fully subject to the Act No. 121/2000 Coll. on Copyright, on Rights Related to Copyright and on Amendment to Certain Acts (Copyright Act), as amended, particularly to Section 35 Paragraph 3; 
· pursuant to Section 60 Paragraph 1 of the Copyright Act, Tomas Bata University in Zlín has the right to conclude a licence agreement on the use of a school work as is specified in Section 12 Paragraph 4 of the Copyright Act; 
· pursuant to Section 60 Paragraphs 2 and 3, I may use my school work – the final thesis – or grant a licence for its use only with the prior written consent of Tomas Bata University in Zlín, which, in such a case, is entitled to require me to pay a reasonable contribution in order to cover the costs incurred by Tomas Bata University in Zlín in connection with the preparation of the work (up to their full amount); 
· if software provided by Tomas Bata University in Zlín or other entities was used for the preparation of the final thesis only for learning or research purposes (i.e. for non-commercial use), the conclusions of the final thesis cannot be used for commercial purposes; 
· if the output of the final thesis includes any type of software product, the source codes and/or files of which the project is comprised are also considered part of the thesis; failure to submit this part may result in failure to defend the thesis.

I hereby declare that

· I have worked on my final thesis independently and have properly cited the literature used; in the event of publication of its conclusions, I shall be listed as a co-author;
· the submitted hard copy of the final thesis and the electronic version uploaded to the IS/STAG are identical in content.



In Zlín on ..............................	...............................................................
	author’s signature




Abstrakt
Abstract in Czech. The abstract provides a brief, precise, specific and concise summary of the content of the thesis. Its purpose is to enable the reader to memorise and identify key information and facts about the thesis. It should clearly present the objectives, content, methods used, results, and the significance of the final thesis. The abstract should be 5 to 10 lines long. Keywords should highlight the most important aspects of the text. They are typically single words or multi-word expressions, fixed phrases, personal names, names of organisations, names of objects, etc. Keywords are separated by commas and begin with a lowercase letter (unless they are proper nouns). A thesis should include between 3 and 8 keywords. The abstract and keywords must be written in the language of the thesis, along with their English equivalents. For theses written in a language other than Czech, the abstract and keywords must also be provided in Czech or Slovak. At the Department of Modern Languages and Literatures at the Faculty of Humanities, final theses in the degree programme in German for Business Administration include three abstracts: in Czech, English and German. A tool and guidelines for generating keywords are available at: https://keywords.k.utb.cz. The identical text of the abstract and identical keywords must be entered into IS/STAG system.

Klíčová slova
klíčové slovo, klíčové slovo, klíčové slovo

Abstract
Abstract in English. The abstract should be 5 to 10 lines long. The same text of the abstract must be inserted into IS/STAG.

Keywords
keyword, keyword, keyword






You can write acknowledgements here (optional).
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The List of Figures is generated automatically (with label Figure). After completing the thesis, it is necessary to update it (right-click on the list and select Update field).
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The List of Tables is generated automatically (with label Table). After completing the thesis, it is necessary to update it (right-click on the list and select Update field).
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Abbreviation	Meaning of the abbreviation 
The List of Abbreviations, including their explanations, is created using tabs. Abbreviations/symbols will be aligned to the left margin, followed by their explanation after the tab. Another abbreviation/symbol can be added by clicking on the plus icon after hovering the mouse over the line with the list. The list is sorted alphabetically.
Note: In the text of the thesis itself, abbreviations must always be explained at the first occurrence of the abbreviation in the text (in brackets or in a footnote, if it is a more complex explanation of a concept or abbreviation), but common, established connections are not given.
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Appendices included in the final thesis
Appendix A:	List of template styles
Appendix B:	List of Quick Parts and Building Blocks
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The List of Appendices included in the final thesis is generated automatically, after completing the thesis it is necessary to update it (right-click on the list and select Update field). The list of other attachments is created manually.



[bookmark: _Toc215419443]Introduction
The template is intended for Bachelor’s, Master’s or advanced Master’s (rigorosum) theses submitted at Tomas Bata University in Zlín (hereinafter referred to as TBU). It is based on the current Rector’s Directive – Rules Governing the Assignment, Preparation, Submission, Public Access and Originality Check of Bachelor’s, Master’s and Advanced Master’s (Rigorosum) Theses, which is available at https://www.utb.cz/univerzita/uredni-deska/
vnitrni-normy-a-predpisy/smernice-rektora.  
We recommend that you study this Directive or the directive of the relevant faculty on its website. The manual and templates were updated in September 2025.
The latest versions of the thesis templates are available on the TBU website in the section https://www.utb.cz/en/student-2/documents-and-templates/thesis-templates/.
Several versions of the template are available for students of all faculties: MS Word versions (Czech, English and German versions, and a version for international students with an English declaration), LibreOffice / OpenOffice versions (Czech, English and German versions, and a version for international students with an English declaration) and LaTeX versions (Czech and English versions – the template language and declaration language can be set using a toggle).
[bookmark: _Toc215419444]Guidelines for Formatting Final Theses and Individual Faculties
The thesis template is designed for universal use across all faculties of TBU. It is not recommended to alter the predefined settings of the unified template (such as double-sided layout, font type and size, line spacing, etc.). The template is structured to support the creation of various types of academic texts while ensuring a consistent format and appearance.
Each faculty may also have its own specific requirements for the formatting of final theses. These typically concern the structure of the thesis, formal layout, recommended length or citation guidelines. The specific requirements of individual faculties are detailed in faculty-level directives, which students are required to study thoroughly. 
The following chapter includes at least the basic faculty-specific guidelines that students should familiarise themselves with at the beginning of their work. Despite the authors’ efforts to ensure that the template meets all necessary standards and requirements, there may be cases where the nature of a particular thesis necessitates adjustments to certain styles. In such instances, we recommend consulting the thesis supervisor or following the established conventions of the respective academic discipline.
[bookmark: _Toc215419445]Faculty of Technology
Students of the Faculty of Technology use the ČSN ISO 690 citation standard (in its current version) for their final theses. The mandatory referencing method is the numerical citation style (the reference number is placed in square brackets). In the list of references, bibliographic citations are organised according to their occurrence in the thesis, in a numbered list.
Recommended structure of the main content for an experimental thesis:
Introduction
Theoretical Part of the Thesis (theoretical background of the work)
Objectives of the Thesis
Experimental Part of the Thesis (methodology of the work)
Results and Their Discussion
Conclusion
Recommended structure of the main content for a research thesis:
Introduction
Theoretical Analysis (detailed processing of the researched area)
Discussion
Conclusion	
[bookmark: _Toc215419446]Faculty of Management and Economics
Students of the Faculty of Management and Economics use the ČSN ISO 690 citation standard (in its current version) for their final theses. The mandatory referencing method is the Harvard system (name-date style). In the list of references, bibliographic citations are arranged alphabetically (this list is not numbered). Every source cited in the text of the Bachelor’s/Master’s thesis must also appear in the reference list, and vice versa. If a student, in consultation with their thesis supervisor, uses a generative artificial intelligence (AI) model as a supporting tool while working on their Bachelor’s/Master’s thesis, they must state the name and website of the application(s) in the introduction and justify the purpose of its use. The use of AI in the thesis text and the reference list must be properly cited according to the citation standard. When using AI, the student must adhere to the available guidelines and recommendations from TBU regarding AI tools. The author of the Bachelor’s/Master’s thesis bears full responsibility for the content.
The formal layout of the thesis follows the prepared template and the styles contained within it. 
The Bachelor’s/Master’s thesis must be logically structured, include correct technical terminology, adhere to the prescribed citation standard, and meet the required linguistic and graphical quality. During the process of writing the Bachelor’s/Master’s thesis, the requirement for at least three consultations with the thesis supervisor must be fulfilled.
Tables and figures must include the source, even if the source is the author’s own. Scanned or photographed images can only be used with the consent of the original author or publisher; otherwise, there is a risk of copyright infringement. The template recommends using so-called Quick Parts for proper source referencing for tables or figures. For figures, select the Quick Part labelled “IMAGE (with source citation)”. For tables, choose “TABLE (caption above)”, which includes a prepared caption for the table and an empty paragraph where the table can be inserted in the usual way. The source should be written in the paragraph below the table, and the text should be formatted with the style “Source of the image/table”. A reference to every image, table or appendix must appear in the main text of the Bachelor’s/Master’s thesis. Charts are considered figures (they are labelled with the same caption as figures, must be properly cited, and listed in the list of figures).
The thesis author should choose and maintain a consistent writing style, including the choice of person (the use of the authorial plural is not common at the FaME).
Recommended structure of the thesis (based on the unified template, i.e. the thesis does not contain separate theoretical/practical sections):
Introduction
Theoretical Background
Methodology
Results
Conclusion
The recommended length of chapters is specified in the relevant Dean’s Directive, currently in force.
(With reference to Introduction) The introduction of the Bachelor’s/Master’s thesis should include a justification for the choice of topic, its relevance, the definition of the problem being addressed, the expected contributions and the structure of the thesis. A key element of the introduction is the statement of the main objective.
(With reference to Theoretical background) A critical discussion of the literature is an integral part of the Theoretical Background chapter. For research-oriented theses, it is appropriate to formulate working hypotheses based on the literature review.
Domestic and international sources must be chosen carefully and cited appropriately. The recommended minimum number of relevant sources is defined by the Dean’s Directive. Repeated paraphrasing of a single or frequently cited source cannot be considered a quality literature review.
(With reference to Methodology) The Methodology chapter should provide the methodological framework for the Bachelor’s/Master’s thesis. It defines the main objective, partial objectives, research questions, and, if applicable, working hypotheses. The chapter further focuses on describing, justifying, and presenting the data sources, methods of data collection, and methods used for processing the work. The description of the application of the methods must be sufficiently detailed.
(With reference to Results) The Results chapter includes the outcomes of the analysis, as well as subsequent design/research results, which must be interpreted and supported with appropriate arguments. The analysis results should be appropriately based on the theoretical background. The analytical section must be concluded with a summary, ideally emphasising an evaluation of the current state. The subsequent design/research results should be logically connected to the theoretical background and analysis results, and should lead to the fulfilment of the set objectives, in line with the type of final thesis (Bachelor’s or Master’s thesis). Proposals should contain new or improved solutions for the studied area, along with justification supported by relevant arguments.
For a Master’s thesis (MT), in addition to the analysis, the proposal must also include a solution that can be implemented in practice (e.g. a project or scenario). The Results chapter must also include an evaluation of the fulfilment of the main objective, the status of answering the research questions, or the verification of working hypotheses. In the case of a research-oriented Bachelor’s/Master’s thesis, the focus should be on discussing the empirical results obtained through qualitative/quantitative research, and drawing appropriate conclusions to expand knowledge in the field.
(With reference to Conclusion) An essential part of the conclusion is a brief summary of the most important conclusions, findings and recommendations/solutions.
[bookmark: _Toc215419447]Faculty of Applied Informatics
Students of the Faculty of Applied Informatics are required to follow the ČSN ISO 690 citation standard (latest version) in their final theses. The mandatory referencing method is the numerical citation style, where references are indicated using numbers in square brackets. In the list of references, bibliographic entries are arranged in the order in which they appear in the thesis, and the list is numbered accordingly.
The formal layout of the final thesis must follow the provided template and pre-set styles. A specific requirement is the inclusion of the original source for figures and tables. The source (reference in square brackets) must be placed immediately after the caption, not on a new line. 
Recommended structure of the Bachelor’s thesis:
Introduction
Theoretical Framework (optional)
Current State of the Issue
Aims of the Thesis
Experimental Part (e.g. data analysis techniques, research method, etc.)
Results
Conclusion
Recommended structure of the main body of the Master’s thesis:
Introduction
Theoretical Framework (optional)
Current State of the Issue
Aims of the Thesis
Research Questions or Hypotheses
Experimental Part (e.g. data analysis techniques, research method, etc.)
Results
Conclusion
[bookmark: _Toc215419448]Faculty of Humanities
Students of the Faculty of Humanities are required to use a citation style or standard specified by the relevant department, and must familiarise themselves thoroughly with these guidelines. At the Department of Modern Languages and Literatures (ÚMJL), the following citation styles are used: Chicago notes-and-bibliography for theses in literary and cultural studies (written in English), Chicago author-date for theses in linguistics, translation studies and economics (written in English) and ČSN ISO 690 citation standard for theses written in German. At the Departments of Pedagogical Sciences and the Department of School Education (ÚPV and ÚŠP), the APA citation style is used. At the Department of Health Care Sciences (ÚZV), the ČSN ISO 690 citation standard (latest version) is applied.
Detailed information regarding the structure and formatting of theses is provided in internal faculty regulations (Dean’s Directives and decrees issued by the relevant departments). A specific formatting requirement is related to hyphenation. In texts written in English or German, automatic hyphenation must be disabled. Manual hyphenation may be applied if necessary.
[bookmark: _Toc215419449]Faculty of Multimedia Communications
Students of the Faculty of Multimedia Communications are required to follow the ČSN ISO 690 citation standard (latest version) in their final theses.
For degree programmes in the field of Media and Communication Studies, the mandatory referencing method is the Harvard system (author–date method). In the list of references, bibliographic entries must be arranged in alphabetical order (the list is not numbered). For degree programmes in the field of Arts, the required referencing method is the footnote citation system. Bibliographic entries in the list of references are also to be arranged in alphabetical order (the list is not numbered).
Recommended structure of the main body of the thesis for the field of Media and Communication Studies (degree programmes such as Media and Communication Studies, Marketing Communications):
Introduction
Theoretical Part
Practical Part
Project Part (for follow-up Master’s programmes)
Conclusion
For the field of Arts (degree programmes such as Multimedia and Design, Multimedia, Design, Theory and Practice of Audiovisual Production, Theory and Practice of Animated Production, Animated Production, Arts Management, Creative Industries and Digital Culture, and other related programmes):
Introduction
Textual and Documentation Part
Conclusion

[bookmark: _Toc215419450]Template Preparation and Working with the Template
This chapter provides information on how to install the template, edit the introductory and final pages, enable double-sided printing, and convert the final thesis to the PDF/A format. It is intended to include all the essential guidance students may need in order to use the thesis template easily. The instructions apply exclusively to students who have chosen templates for MS Word or Writer (LibreOffice / OpenOffice).
Important notice for using the template in MS Word: The template was developed for MS Word 2016 (or newer). It will also function correctly in MS Word 2013. Minor issues may occur in versions 2007 and 2010, although the template should still be usable. The template is not compatible with MS Word 2003 or earlier, as these versions are no longer supported. Word Online (as part of Office 365) and Word for Android/iOS are not full-featured applications like the desktop version of Word; therefore, the template will not work properly in these environments.
The template is provided as a DOTX file, and thus requires installation before use (see Chapter 2.1 Template Installation).
Every student at Tomas Bata University (TBU) is entitled to use the Microsoft 365 Office suite. Access is available at portal.office.com, where students can download the installation package for their device (login requires university credentials). The software can be installed on up to five different devices (Windows or macOS).
Important notice for using the template in Writer: The template was created for use in the free office suites LibreOffice and OpenOffice. It is provided as an ODT file, which does not require any additional installation.
The latest versions of thesis templates are available on the TBU website, in the section: https://www.utb.cz/en/student-2/documents-and-templates/thesis-templates/.
[bookmark: _Ref214294300][bookmark: _Toc215419451]Template Installation
As mentioned above, the template for use with the freely available office suites LibreOffice or OpenOffice does not require installation into the template system, as it is provided in the form of an ODT file. In contrast, the template for MS Word does require installation prior to creating a new document for the first time. This chapter is therefore primarily intended for users of Microsoft Word. The recommended steps for using the MS Word template are as follows:
Download the template file (DOTX) and save it to the location where you intend to work on your thesis (it is advisable to create a dedicated folder in any convenient location on your computer or an external drive for this purpose).
Create a new document by double-clicking the template file.
Save the new document (DOCX file) in the same folder as the template.
Write and edit your thesis in this newly created document.
If transferring the document to another computer, ensure the template file is also transferred and kept in the same folder.
The template includes so-called Quick Parts, which are pre-prepared text blocks designed to facilitate certain tasks (e.g. inserting an image along with a pre-formatted caption in one step). These Quick Parts are part of the template itself and are not embedded into documents based on the template. Therefore, the thesis document must maintain access to the template throughout the writing process. If students work on their thesis using multiple devices (e.g. at home and at university) and wish to use the Quick Parts feature, they must ensure that the template file is available on all these devices. If the document loses access to the template, Quick Parts will no longer be available. For instance, if a document is created on a university computer, but only the document (without the template) is transferred to a home computer, the Quick Parts functionality will be missing.
For this reason, it is strongly recommended to always keep both files – the template (DOTX) and the thesis document (DOCX) – together in the same folder throughout the writing process. You may of course work with multiple such documents if needed.
Please note that the template is not required for the final formatting or submission of the thesis. It is also not necessary to send the template to your thesis supervisor for review. The final file submitted should be a standard Word document (DOCX), which should then be converted to PDF before submission.
[bookmark: _Toc215419452]Editing the Introductory and Final Pages of the Template
Templates for MS Word as well as for freely available alternatives such as LibreOffice or OpenOffice have been designed for universal use. Their aim is to offer, within the given technical limitations, the simplest possible method of writing a final thesis that meets both formal and visual requirements.
The initial sections of the template use form fields, which can be easily clicked on to enter custom text or select one of the predefined options. These fields are most often displayed in [square brackets].
On the title page, it is necessary to complete the following: the title of the thesis (with an initial capital letter), the author’s full name (including any academic degrees) and the year of submission. From the available options, you must also select the correct type of final thesis and the appropriate faculty.
The second page contains a red notice and the university logo. The red text is an instructional notice and must be deleted before submitting the thesis.
An important part of the introductory pages are the sections used for inserting the official assignment of the thesis, which must be included in the form of an image. In MS Word, click on the blue form control button to insert an image, then select the scanned assignment image via the dialogue box. In this way, both pages of the assignment can be inserted one after the other. The image may be adjusted if necessary. In LibreOffice Writer, right-click on the blue form control and select Replace, then choose the scanned assignment image in the dialogue window. Both pages of the assignment are inserted in the same way, and the image can be adjusted afterwards if needed. 
If your thesis assignment consists of three pages, we recommend the following steps:
Insert the first two pages of the assignment using the method above.
Right-click on the image of the second page and select Copy.
Click the mouse to the right of the image until the cursor starts blinking (in Word, it may also be necessary to press the right arrow key to move the cursor outside the form frame), and insert a new blank page using the Ctrl + Enter shortcut.
Paste the copied image with the second page of the assignment using the Ctrl + V shortcut.
Right-click on the pasted image and choose Change Picture (in Word) or Replace (in Writer), then insert the third page of the assignment.
In the electronic PDF version uploaded to the IS/STAG system, the assignment must be included without signatures. The original signed version of the assignment will be added to the printed copy of the thesis for archiving purposes.
Author’s Declaration: As with the assignment, the declaration in the PDF version uploaded to IS/STAG must not include a signature.
The page with the abstract and keywords in Czech and English (or possibly in another language) contains the same texts and keywords that will later be entered into IS/STAG. Click on the square brackets to insert your own texts.
Next comes the Acknowledgements page, which is optional. If you choose not to include acknowledgements, simply click inside the frame and follow the instructions provided to remove the entire block and the page.
After the introductory pages, the template continues with automatically generated contents and lists. Some lists (e.g. figures, tables, appendices) are generated automatically, while others (e.g. abbreviations, supplementary appendices) must be created manually. Once the thesis is complete, you must update the automatically generated content and lists (right-click on the list or table of contents and select Update). Lists are not mandatory and may be removed if not used. You may also create custom lists (e.g. a list of charts). A detailed guide for creating or removing custom lists can be found in Chapter 4.5 Automatically Generated Lists.
After the main body of the thesis, the template includes the Bibliography, which must always be compiled in accordance with the citation standard or referencing style used in the thesis.
The thesis template also contains preformatted pages for any appendices. If your thesis does not include appendices, this section may be removed according to the instructions provided within the appendices block.
[bookmark: _Toc215419453]Converting the Thesis to PDF/A
According to the currently valid Rector’s Directive on final theses, available at https://www.utb.cz/univerzita/uredni-deska/vnitrni-normy-a-predpisy/smernice-rektora/ students are required to submit electronic versions of their final theses (Bachelor’s, Master’s, and advanced Master’s theses) in the PDF/A format (specifically, PDF/A-1b standard).
Please note: The template is designed for double-sided printing. As a result, certain pages – particularly introductory sections and lists – are formatted to always appear on odd-numbered pages (such as the table of contents, list of figures, etc.). Therefore, it is possible that one odd-numbered page (e.g. page 7) is followed by another odd-numbered page (e.g. page 9). This is not an error. When exporting to PDF, Word (or an equivalent word processor) will automatically insert a blank page between such odd-numbered pages. These blank pages are considered part of the thesis and must remain in the final document submitted by the student.
Clear instructions are also available on the Library website: https://iva.k.utb.cz/
wp-content/uploads/i_want_to_safe_my_final_thesis_as_a_PDF-A_document_web.pdf. 

Microsoft Word (Windows)
In MS Word, go to File – Export, then click on Create PDF/XPS Document. In the save dialogue, click Options, and make sure the box ISO 19005-1 compliant (PDF/A) is checked.

Microsoft Word (macOS)
Microsoft Office for macOS does not support direct export to PDF/A format. Therefore, the document must first be exported as a regular PDF and then converted to PDF/A. Please note that functionality may vary depending on your macOS version and hardware.
Conversion using Preview app: Open the PDF document in Preview. Go to File – Export, select PDF as the format, and tick the box for PDF/A.
Conversion using Adobe Acrobat Pro: Open the PDF in Adobe Acrobat Pro. Select File – Save As, then choose PDF/A as the format. Click Options/Settings and ensure Save as PDF/A-1b is selected.

LibreOffice Writer (Windows, Linux, macOS)
In LibreOffice Writer, go to File – Export As – Export as PDF. In the dialogue window, under the General tab, tick Archive (PDF/A-1b). Under the Structure section, make sure to tick Export automatically inserted blank pages.

LaTeX
This template is already configured to export documents in PDF/A-1b format by default.
[bookmark: _Ref214316241][bookmark: _Toc215419454]Document Preview and Printing
The template is designed to allow for double-sided printing: it features mirrored margins as well as mirrored headers and footers. Both the Microsoft Word template and its alternatives use sections to ensure that certain pages are always set as odd-numbered (this primarily applies to introductory pages and lists). 
You can view the document layout using print preview or the “book view” option (in LibreOffice Writer).
[image: ]
[bookmark: _Toc214401390]Figure 1: Example of document layout with an inserted blank page
As a result, you may notice that one odd-numbered page (e.g. page 7) is followed by another odd-numbered page (e.g. page 9). This is not an error. During printing, Word (or its alternative) will insert a blank page between these two odd pages. The same applies when exporting the document to PDF. These blank pages are an integral part of the thesis and must be included by students in the final version.
Before printing the thesis or converting it to PDF in Word (or its alternative), all lists, cross-references, captions, the table of contents and other fields must be updated. In Word, this is done by selecting the entire document (shortcut Ctrl + A) and pressing F9. In the dialogue boxes that appear, it is recommended to confirm the update of the entire tables. In Writer, go to the main menu, select Tools, then choose Update and Update All.

[bookmark: _Toc215419455]Styles
When working with the thesis template, it is recommended to use the predefined styles and formatting in order to maintain a consistent layout throughout the document. Students should avoid using direct formatting (such as manual changes to font type, size, or heading properties). The required styles can be found in the Styles panel, which can be accessed in Word via the Home tab (then Styles), and in Writer by pressing the F11 key. 
The following formatting settings and instructions for using styles are primarily intended for use with Microsoft Word (a similar approach can be followed in LibreOffice Writer). If using the LaTeX template, it is necessary to follow the commands and instructions specific to that environment.
A list of the predefined styles for text editors can be found in the appendix to this manual – see Appendix A: List of template styles.
[bookmark: _Ref215409177][bookmark: _Ref215409182][bookmark: _Toc215419456]Headings
The template includes four sets of heading styles: unnumbered headings (used for introductory and concluding sections and for lists), numbered headings for the main body of the thesis, section headings (with alphabetical labelling) and appendix headings. An overview of the heading styles and their levels is shown in the table below. Only the headings marked with an asterisk (*) are included in the generated table of contents.
[bookmark: _Ref214402340][bookmark: _Toc214401416]Table 1: Heading styles
	Level
	Numbered heading
	Unnumbered headings
	Section headings
	Appendices

	1
	Heading 1*
Heading 1 after divider*
	Headings for introduction + conclusion*
Lists heading*
Other headings
	Divider heading*
	Appendix 1

	2
	Heading 2*
	
	
	Appendix 2

	3
	Heading 3*
	
	
	

	4
	Heading 4
	
	
	

	5
	Heading 5
	
	
	



First-level headings always start on a new page. This requirement should be managed automatically by the word processor. An exception is the style Heading 1 after divider, which is used immediately after a section heading in the split template layout (e.g. after the heading A THEORETICAL PART, which appears on a new page, the heading 1 Theory follows on the same page). This specific heading style is included in the Word template. For the split template in Writer, please follow the instructions provided within that particular template.
Numbered headings in the main body of the thesis are included in the table of contents up to level 3. Headings at levels 4 and 5 are available in the template but are not included in the table of contents and should only be used in justified cases.
Unnumbered headings are intended for use in lists (e.g. list of figures, tables, references), in the introduction and conclusion, or for other document sections such as the abstract, declaration, etc. Among these, the headings for the lists, introduction and conclusion are included in the table of contents.
Section headings are intended for theses that require division into separate parts (e.g. theoretical and practical parts). These headings are formatted using uppercase letters (A, B, C…) and capital letters (all caps).
Appendix headings are used when appendices are included in the thesis. First-level appendix headings are transferred to the List of Appendices.
All headings that appear in the table of contents also appear in the navigation panel, which can be used to navigate the document quickly and efficiently. In Word, it can be activated via the View tab by ticking the Navigation Panel checkbox. In Writer, the so-called Navigator is opened by pressing F5.
[bookmark: _Toc215419457]Headings for Split and Non-Split Templates
According to the guidelines of individual faculties and departments, it is possible to work with either a split or non-split version of the template. The split template visually divides the thesis into separate sections, such as Theoretical Part and Practical Part. For this purpose, specific heading styles are prepared in both Word and Writer to assist in structuring the thesis accordingly. The non-split template does not use this division and treats the thesis as a single continuous document.
The split template uses a first-level heading style called Divider heading, which ensures a visual separation into distinct parts – for example, A THEORETICAL PART, B PRACTICAL PART. This heading style always starts on a new page and follows an alphabetical labelling system. In Word, this heading is followed by the style Heading 1 after divider, which shares the formatting properties of the main Heading 1 style but does not start on a new page. 
[image: ]
[bookmark: _Toc214401391][bookmark: _Ref215417991]Figure 2: Example of a split template using section headings
In Writer, it is necessary to manually adjust the headings. After the Divider heading style, the Heading 1 style follows, which is set to always start on a new page, as it represents a first-level heading. This setting will be necessary for the subsequent chapters of the thesis. Therefore, in this particular case, the page break must be removed manually. For the page break between the part heading on one page and the chapter with the Heading 1 style on the next page, it is necessary – according to Figure 3 to click on the dropdown menu between the pages and select the Delete Page Break option. The Heading 1 will then move to the same page as the part heading, as shown in Figure 2Chyba! Nenalezen zdroj odkazů..
[image: ]
[bookmark: _Toc214401392][bookmark: _Ref215417981]Figure 3: Demonstration of how to remove a page break in Writer
[bookmark: _Ref215417061][bookmark: _Ref215417069][bookmark: _Toc215419458]Paragraphs
The template includes two styles for the main body text: First paragraph and Next paragraphs. Paragraphs are justified and hyphenation is enabled.
The First paragraph style has no first-line indent and is used for the first paragraph following a heading, figure, table or quotation. This style is set as the default style following any heading style, and it is automatically applied when a heading is ended by pressing Enter. 
Subsequent paragraphs are formatted using the Next paragraphs style, which includes a first-line indent of 0.8 cm and is intended for all other paragraphs except the first. This style is set as the default following the First paragraph style.
[bookmark: _Ref215417369][bookmark: _Ref215417373][bookmark: _Toc215419459]Lists
The template includes styles for Alphabetical List, Numbered List, Bulleted List and Multilevel List. The indentation for each list item is set to 0.8 cm. These styles automatically add spacing before the first and after the last line of the list.
The Alphabetical and Numbered Lists are prepared as single-level lists. If multiple numbered or alphabetical lists are used throughout the thesis, it is important to always reset the numbering to start from 1. In Word, after selecting the list with the mouse, right-click within the list and choose the option Restart at 1. In Writer, after selecting the list with the mouse, right-click and from the menu select List and then Restart Numbering.
Alphabetical list
Alphabetical list
Alphabetical list

Numbered list
Numbered list
Numbered list
The Bulleted List is prepared as a single-level list, but it can be used for multiple levels by using the Tab key to create sub-items.
Bulleted list
Bulleted list
Bulleted list
Example of possible indentation (using Tab)
Example of possible indentation (using Tab)
Example of possible indentation (using Tab)
Example of possible indentation (using Tab)
Multilevel Lists are formatted with the Multilevel List style. In the Home tab, under the Paragraph section, click the arrow next to the Multilevel List button to open the numbering gallery, where a multilevel list style is preconfigured.
Multilevel list
Multilevel list
a) Next level of the multilevel list (created using Tab)
i) Next level
ii) Next level
b) Next level of the multilevel list (created using Tab)
Multilevel list
[bookmark: _Ref207227533][bookmark: _Ref207227537][bookmark: _Ref207227614][bookmark: _Ref207227621]Multilevel list
[bookmark: _Ref215408816][bookmark: _Ref215408821][bookmark: _Ref215417397][bookmark: _Ref215417403][bookmark: _Toc215419460]List of References (Bibliography)
There are two styles available for creating a bibliography: Bibliography (alphabetical list) and Bibliography (numbered list). The appropriate style should be chosen according to the citation standard or referencing style applied in the thesis.
The Bibliography (alphabetical list) style is intended for theses that organise sources alphabetically, typically by the author’s surname. This includes citation standards such as ČSN ISO 690 (author-date method or Harvard system), as well as citation styles such as APA and Chicago. The style uses a hanging indent of 0.8 cm and a font size of 11 pt. Below is an example of an alphabetical list of used sources (according to ČSN ISO 690:2022).

BREGNHØJ, Mikkel; THORNING, Frederik a OGILBY, Peter R., 2024. Singlet Oxygen Photophysics: From Liquid Solvents to Mammalian Cells. Online. Chemical Reviews. Vol. 124, no. 17, p. 9949-10051. ISSN 0009-2665. Available from: https://doi.org/10.1021/acs.chemrev.4c00105. [Accessed 2024-10-28].
EARLE, Richard. The art of cause marketing: how to use advertising to change personal behavior and public policy. Monica BAZIUK (cover and interior design). New York: McGraw-Hill, 2000. ISBN 0-07-138702-1.
KALENDA, Jan, 2021. Vratký triumf: vývoj účasti na neformálním vzdělávání dospělých v České republice v letech 1997 až 2016. Online. Zlín: Univerzita Tomáše Bati. ISBN 978-80-7454-986-1. Available from: https://doi.org/10.7441/978-80-7454-986-1. [Accessed 2024-02-19].

The Bibliography (numbered list) style is primarily intended for technical and technological disciplines, which use the ČSN ISO 690 citation standard with the numeric referencing method, where references are indicated by numbers in square brackets. The indentation is also set to 0.8 cm and the font size is 11 pt. Below is an example of a numbered list of used sources (in accordance with ČSN ISO 690:2022).

GIBSON, Robert. Choosing your message. Business Spotlight. 2012, vol. IX, no. 6, p. 24-29. ISSN 1214-8377. 
EARLE, Richard. The art of cause marketing: how to use advertising to change personal behavior and public policy. Monica BAZIUK (cover and interior design). New York: McGraw-Hill, 2000. ISBN 0-07-138702-1.
KALENDA, Jan. Vratký triumf: vývoj účasti na neformálním vzdělávání dospělých v České republice v letech 1997 až 2016. Online. Zlín: Univerzita Tomáše Bati, 2021. ISBN 978-80-7454-986-1. Available from: https://doi.org/10.7441/978-80-7454-986-1. [Accessed 2024-02-19]. 
JANISSEN, Brendan a HUYNH, Tien. Chemical composition and value-adding applications of coffee industry by-products: A review. Online. Resources, Conservation and Recycling. 2018, vol. 128, p. 110-117. ISSN 09213449. Available from: https://doi.org/10.1016/j.resconrec.2017.10.001. [Accessed 2022-05-09]. 

In both styles, it is recommended to visually highlight authors’ names using bold typeface. This must be applied manually and is optional, but should be applied consistently throughout the entire list if used. For more detailed information on citation standards and referencing styles, as well as citing sources and compiling a bibliography, see 4.6 List of References (Bibliography).
[bookmark: _Ref215417215][bookmark: _Ref215417220][bookmark: _Toc215419461]Quotations and Poetry
Short quotations (usually up to three lines, or up to 40 words at the Department of School Education (ÚŠP) of the Faculty of Humanities) are included directly within the main body of the text. Such quotations must be distinguished from the surrounding text using quotation marks, and the source must be cited in accordance with the referencing standard or citation style used. 
Longer, single-paragraph quotations are separated from the main text by a 12-point space before and after, and are indented 1.4 cm from the left margin. The Quote style is used for formatting these block quotations, which includes spacing before and after the quoted text and automatically sets the style of the following paragraph to First paragraph. Block quotations are not enclosed in quotation marks, but the source must be cited at the end of the quotation.
Lorem Ipsum is simply dummy text of the printing and typesetting industry. Lorem Ipsum has been the industry’s standard dummy text ever since the 1500s, when an unknown printer took a galley of type and scrambled it to make a type specimen book. It has survived not only five centuries, but also the leap into electronic typesetting, remaining essentially unchanged. It was popularised in the 1960s with the release of Letraset sheets containing Lorem Ipsum passages, and more recently with desktop publishing software like Aldus PageMaker including versions of Lorem Ipsum. (Source, 2025)
In a similar manner, the Quote style (USP-FHS) is designed specifically for students of the Department of School Education (ÚŠP) at the Faculty of Humanities. This style shares most of the same formatting features as the main quotation style, but the font size is set to 10 pt.
Lorem Ipsum is simply dummy text of the printing and typesetting industry. Lorem Ipsum has been the industry’s standard dummy text ever since the 1500s, when an unknown printer took a galley of type and scrambled it to make a type specimen book. It has survived not only five centuries, but also the leap into electronic typesetting, remaining essentially unchanged. It was popularised in the 1960s with the release of Letraset sheets containing Lorem Ipsum passages, and more recently with desktop publishing software like Aldus PageMaker including versions of Lorem Ipsum. (Source, 2025)
Quotations consisting of multiple paragraphs can be formatted using a combination of styles: Quote beginning for the first paragraph, Quote continue for the subsequent paragraphs, and Quote end for the final paragraph. After the last paragraph, the First paragraph style is automatically applied. Additionally, individual paragraphs can be indented from the left using various indentation levels (tab stops are set at multiples of 1.4 cm).
Lorem Ipsum is simply dummy text of the printing and typesetting industry. Lorem Ipsum has been the industry’s standard dummy text ever since the 1500s, when an unknown printer took a galley of type and scrambled it to make a type specimen book (Source, 2025).
	“A tab-indented sentence.”
		“A tab-indented sentence.”
It was popularised in the 1960s with the release of Letraset sheets containing Lorem Ipsum passages, and more recently with desktop publishing software like Aldus PageMaker including versions of Lorem Ipsum.
To format short excerpts of text (single-line sentences), such as poetry or song lyrics, the Poetry style is available. Stanzas are separated by a 12-point space before and after, and are indented 1.4 cm from the left margin. The text is left-aligned. Individual lines within a stanza can also be indented using different levels (tab stops again set at multiples of 1.4 cm).
When formatting poetry or songs, each stanza (paragraph) should be ended by pressing Enter, while each line (verse) should be ended using a line break (Shift + Enter).
Lorem ipsum dolor sit amet
Consectetuer molestie Quisque tincidunt quis
Curabitur vitae condimentum lacinia risus
Urna Curabitur laoreet felis augue
Dis est ut laoreet
Adipiscing justo est eros sed
Sollicitudin nulla adipiscing augue consequat
Quisque id tempor eros nec
[bookmark: _Ref215417270][bookmark: _Ref215417276][bookmark: _Toc215419462]Linguistic Examples
Example of formatting linguistic examples in academic writing with continuous numbering throughout the thesis (numbering is enclosed in round brackets). The indentation for each example is set to 0.8 cm. The style used is Linguistics numbered examples.
If it is necessary to include multiple lines within one example, each line should be ended with a line break (Shift + Enter). When using single-line examples, it is advisable to manually align the text to the left (as the default alignment is justified).
*Lorem Ipsum is simply dummy text of the printing and typesetting industry. Lorem Ipsum has been the industry's standard dummy text ever since the 1500s, when an unknown printer took a galley of type and scrambled it to make a type specimen book.
[bookmark: _Ref207049743][bookmark: _Ref214316347]*Lorem Ipsum is simply dummy text of the printing and typesetting industry.
*Lorem Ipsum is simply dummy text of the printing and typesetting industry.
If the main text continues after the example, make sure to apply the correct subsequent style, First Paragraph of Thesis. If more examples follow later in the document, they should be continuously numbered. In case the automatic numbering does not function properly, it must be manually adjusted and verified (In Microsoft Word, highlight the example with your mouse, right-click it, and select “Continue Numbering”. In LibreOffice Writer, highlight the example, right-click, and from the menu select List – Add to List).
a. [line 1]			note indented using the Tab key, line wrapped
b. [line 2]			note indented using the Tab key, line ended
a. [line 1]			note indented using the Tab key, line wrapped
b. [line 2]			note indented using the Tab key, line ended
In some cases, it is helpful to use cross-references to individual examples for better orientation in the text. On the Insert tab, simply click the Cross-reference button (a similar procedure applies in Writer). In the “Reference type” dropdown menu, choose the desired numbered item (in Writer, “Numbered Paragraph”), e.g. (2), and under “Insert reference to”, select Paragraph number. More information on cross-references is provided in Chapter 4.4 Cross-references. It is important to ensure that cross-references are updated in case of later changes – see Chapter 2.4 Document Preview and Printing.
It is also possible to include examples without automatic numbering. In such cases, the style Linguistic Examples is available. This style does not use continuous numbering, but lines are indented by 0.8 cm to visually distinguish the example from the main text.
Lorem Ipsum is simply dummy text of the printing and typesetting industry.
Lorem Ipsum is simply dummy text of the printing and typesetting industry.
[bookmark: _Toc215419463]Footnotes
Footnotes are used to supplement the main body of the text with additional comments, notes, citations or references. They are placed at the bottom of the page and are linked to a specific part of the text, meaning they move along with the text as the document is edited. 
A placeholder (a number) is inserted at the relevant point in the text, formatted as a superscript in bold to clearly distinguish it from the surrounding text. Footnotes are numbered consecutively throughout the entire document. The footnote number should be placed after the punctuation mark, such as a full stop or comma. The footnote text itself is left-aligned and set in 10-point font size.[footnoteRef:2] [2:  This is a sample footnote. Lorem Ipsum is simply dummy text of the printing and typesetting industry. Lorem Ipsum has been the industry’s standard dummy text ever since the 1500s, when an unknown printer took a galley of type and scrambled it to make a type specimen book.] 

Inserting a footnote is straightforward. Place the cursor where the footnote reference number should appear. In Microsoft Word, go to the References tab and click Insert Footnote. In LibreOffice Writer, choose Insert from the main menu, then Footnote and Endnote, followed by Insert Footnote.
[bookmark: _Ref215417324][bookmark: _Ref215417328][bookmark: _Toc215419464]Source Code
To format source code, the predefined Source code style can be used. This style uses the Courier New font at a size of 10 points and is indented 0.8 cm from the left. The text is aligned to the left margin (ragged right). For longer code listings, line numbering is enabled within this style to allow references to specific lines. Line numbering is applied separately on each page.

# Function to calculate factorial
def factorial(n):
if n == 0:
return 1.
else:
return n * factorial(n - 1)

# Get input from the user
number = int(input("Enter a number: "))

# Calculate factorial
result = factorial(number)

# Print the result
print(f"The factorial of {number} is {result}")
Listing 1: Sample caption for a source code listing
The template also includes a dedicated caption type for source code listings, labelled Listing. The nature of some theses requires that source code be clearly labelled to enhance readability and understanding. However, it is not necessary to create a separate list for these captions. Captions for source code use the Caption source code style. The procedure for inserting a caption for source code is as follows:
Word: Go to the References tab and select Insert Caption (then choose the label Listing, add a colon after the listing number, and enter the title of the caption). Afterwards, apply the Source Code Caption style to the caption. If you don't see this caption here, click New caption, click New Label, type the label Listing in the Label box, and then click OK). Then add a colon after the listing number, and enter the title of the caption.
Writer: Use the shortcut Ctrl + F2 (Insert Field), go to the Variables tab, select Number Range in the Type column, choose Listing, and confirm by clicking Insert. This will insert the appropriate listing number. You then need to manually add the label Listing before the number, a colon after it, and the caption title. The entire caption should use the Source Code Caption style.
If line numbering is not required – either for specific examples or throughout the entire thesis – it is possible to use the Source code without line numbers style. This style retains all formatting properties of the parent style but omits line numbering.

[bookmark: _Toc215419465]Embedded Objects, Building Blocks and Quick Parts
The fourth chapter of the manual is dedicated to objects and blocks commonly inserted into final theses. These primarily include figures, tables, equations, as well as cross-references, automatically generated lists, bibliographies and appendices. The aim is to ensure that embedded objects are as consistent as possible with the rest of the template.
Special attention is given to so-called Quick Parts – pre-prepared text blocks in Microsoft Word designed to simplify the workflow for users of the template (for example, inserting an image with a pre-formatted caption in a single step). These Quick Parts are available only in the Word template. When using building blocks via Quick Parts, it is important to check and, if necessary, update the numbering of captions. If new objects are inserted during later revisions, the numbering may become inconsistent. More detailed instructions on how to update caption numbering can be found in Chapter 2.4 Document Preview and Printing.
Information for macOS users: Word does not have a quick parts feature, but there is still a way to use them. There are an Insert button and an AutoText option in the top menu bar. Then search for the relevant building block in the dialog window (by name), or set the search only to a specific template (in the Look in menu) marked TBU. 
[image: Obsah obrázku text, snímek obrazovky, software, Multimediální software

Obsah generovaný pomocí AI může být nesprávný.]
Figure 4: Example of the AutoText feature in macOS
The following instructions primarily refer to working in MS Word (similar procedures can also be followed in LibreOffice Writer). For the LaTeX template, it is necessary to follow the specific commands and instructions of that system. However, there are also certain general principles for working with embedded objects that students should be aware of – regardless of which programme they choose to use when editing their final thesis.
[bookmark: _Toc215419466]Figures
It is important to ensure sufficient resolution of raster graphics/photographs inserted into the formatted text. Images downloaded from internet sources often lack the necessary quality. When inserting images, it is essential to make sure they do not contain an alpha channel (transparency). Since the final version of the thesis must be exported to PDF in the required PDF/A standard, images should be inserted in JPG or PNG format without a transparent background.
Images that are essential to the textual part should be included directly in the text. A list of these images should appear at the beginning of the thesis under List of Figures; once the thesis is completed, this list simply needs to be updated. Larger graphical materials that are not directly related to the text should be placed in the appendices.
Where appropriate, we recommend referring to figures in the text using cross-references. These can be inserted via the Insert tab and the Cross-reference button (a similar procedure applies when using Writer). More information about cross-referencing can be found in Chapter 4.4 Cross-references. It is crucial to ensure that these cross-references are updated after any additional editing, see Chapter 2.4 Document Preview and Printing.
Figures should be placed in separate paragraphs and centred. The Figure style is used for image placement. If the nature of the thesis requires different alignment (which is not recommended due to the aim of unified formatting), the alignment must be changed in the settings of this style. In Writer, alignment must be adjusted using a frame into which the figure is placed after insertion.
All figures must be labelled with a caption in the format Figure X: Image caption, placed below the figure and aligned to the left (do not use a full stop at the end of the caption). The Caption style is used for formatting these captions. 
To simplify working with image placement, captions and formatting, a building block for inserting an image with the appropriate caption is included in the Word template under Quick Parts. In the Insert tab, click Quick Parts and choose the FIGURE caption below block. Then click into the caption field and enter the image title. Captions added using the building block are already correctly formatted with the prefix Figure, eliminating the need to create a new caption manually.

[bookmark: _Toc214401393][bookmark: _Toc208931065]Figure 5: Example of an image caption
All images, especially those not created by the author, must be cited in the thesis. For original photos or artwork, it is appropriate to indicate the source as “own work”. For this purpose, the template includes a caption style called Figure caption with source. Pressing Enter moves the cursor to a new line, which uses the Figure/table source style. To insert such an image with source attribution in Word, use the building block FIGURE with source, where the paragraphs are already formatted with the necessary styles and the caption is prepared.

[bookmark: _Toc214401394][bookmark: _Toc208931066]Figure 6: Example of an image caption with source
(source: own work)
This method is suitable when using, for example, the name-date referencing method or other referencing methods (e.g. numerical references) when it is necessary to emphasize the own work. In some cases, you may be required to provide the source or reference directly on the same line as the caption, rather than on a new line. This is especially relevant when citing using numerical references in square brackets or through footnotes. In such cases, the above-mentioned styles are not used; instead, the basic method for inserting a caption (using the Caption style) is followed. 
Figure X: Image caption with source information on the same line in square brackets [1]
Figure X: Image caption with source information on the same line using a footnote1
Please note, however, that sources or references in brackets will also appear in the List of Figures after it is updated. As their presence in the list is generally undesirable, they should be manually removed from the list after the update.
[bookmark: _Toc215419467]Charts and Diagrams
As with tables, it is advisable to create charts and diagrams directly within the word processor to ensure consistent formatting and to avoid distortion or technical issues during export to PDF. Both Word and Writer use their respective spreadsheet tools, Excel and Calc, in the background. However, one key advantage of creating charts directly in word processors is that they remain editable (charts created solely in spreadsheet applications are usually exported as figures). When using specialised statistical or advanced tools, it is recommended to insert charts directly from these programs (even if only as figures), as recreating them may be more complex or time-consuming.

Chart 1: Chart title
Charts should follow a consistent style (using the same font and a suitable font size to ensure readability). In word processors, we recommend using the sans-serif font Arial, which is also used elsewhere in the template. The recommended font sizes are: 11 pt for the chart title (bold), 9 pt for legends and labels. Colour schemes in charts should not be overly experimental. However, colours used should offer sufficient contrast to ensure readability, even when printed. It is therefore not advisable to use different shades of the same colour. Charts must be clear and easy to understand, and should include a legible legend. It is always important to select the most appropriate type of graph for the data being presented.
Each chart should have a clear title, caption, and, if it is taken from another source, the source must also be provided. Charts should be created in a similar manner to figures. They should be placed in separate paragraphs and centred on the page. The Figure style can be used to position charts. Captions should also be created in a similar way – placed below the chart and left-aligned, without a full stop at the end. The same rules apply to the citation of sources. The caption format should be: Chart X: Chart caption. The styles Caption or Figure caption with source should be used for formatting captions, followed by the Figure/table source style for the source reference.
Chart X: Chart title
If appropriate in the body text, we recommend referring to the chart using a cross-reference. This can be inserted via the Insert tab and the Cross-reference button (a similar process applies in Writer). For more information on cross-references, see Chapter 4.4 Cross-references. It is important to ensure that all cross-references are updated if changes are made later – see Chapter 2.4 Document Preview and Printing.
If the thesis contains a large number of charts, it is advisable to include a List of Charts in the introductory lists section and place it on a new page after the List of Figures. The procedure for creating an automatically generated list for charts is described in 4.5 Automatically Generated Lists.
[bookmark: _Toc215419468]Tables
When inserting tables into the text, it is recommended to ensure a consistent appearance (regular spacing between columns and rows, limited colour palette for cell fillings, limited range of font sizes and styles). Both Word and Writer offer a wide variety of table formatting styles; however, it is important to keep in mind that the content of the table is more important than the use of various colours, borders and shading. For this reason, a black-and-white design is recommended. In word processors, it is advisable to use the sans-serif font Arial (font size 11 pt for table headings and 9 pt for the content of individual cells, which ensures good readability even in larger tables).
For consistency, any externally sourced tables should be retyped and recreated directly in the word processor to ensure uniform formatting.
Tables must not extend beyond the set page margins. Large tables should be placed in separate appendices.
Table captions are placed above the tables, left-aligned, and labelled as follows: Table X: Table caption (note: no full stop after the caption). The template includes a List of Tables for this purpose. Once the thesis is complete, this list should simply be updated.
Where appropriate, we recommend referring to tables in the text using a cross-reference. This can be inserted via the Insert tab and the Cross-reference button (the same applies to Writer). More information on cross-references is provided in 4.4 Cross-references. It is important to ensure that these cross-references are updated if any changes are made – see Chapter 2.4 Document Preview and Printing.
A building block for table insertion is available in Word’s Quick Parts. On the Insert tab, click Quick Parts, then select the block TABLE caption above. This building block contains only a prepared table caption (using the Table caption style, left-aligned) and a blank paragraph where the table itself can be inserted (via the Insert – Table button). If a table does not fit on a single page, the header row must be repeated on all subsequent pages. The procedure for setting repeating headers in multi-page tables is as follows:
Word: Select the first row of the table, go to the Table Layout tab, choose Data, and click Repeat Header Rows. Word will automatically repeat the header on following pages.
Writer: Select the first row of the table, go to the Table menu in the main toolbar, and choose Header Rows Repeat Across Pages. 
Leave a blank paragraph below the inserted table so that it is not “stuck” to the text that follows. Any externally sourced tables must be cited. Tables are cited in a similar manner to figures. The source should be placed directly below the table using the Figure/table source style (it is necessary to move the cursor to the line below the table, see Table 2). This method is suitable when using, for example, the name-date referencing method or other referencing methods (e.g. numerical references) when it is necessary to emphasize the own work.
In some cases, it may be required that the source (or reference to it) be included on the same line as the table caption rather than on a new line. This applies especially when using numbered references in square brackets or the footnote method: 
Table X: Table caption with source information in square brackets [1]
Table X: Table caption with source information using a footnote1
Please note: Sources (references) included in square brackets will also appear in the List of Tables, which is not ideal. These should be manually removed from the list after updating.
[bookmark: _Ref215421262]Table 2: Table caption
	One
	Two
	Three
	Four
	Five
	Six
	Seven

	First row
	
	
	
	
	
	

	Second row
	
	
	
	
	
	

	Third row
	
	
	
	
	
	

	Fourth row
	
	
	
	
	
	

	Summary
	
	
	
	
	
	


(source: own work)
[bookmark: _Ref215417304][bookmark: _Ref215417308][bookmark: _Toc215419469]Equations
Equations and formulas are placed on a separate line, centred and numbered (the equation number is right-aligned). For visual formatting of equations and formulas, the Equation style with the Cambria Math font is used.
In the Word template, a building block for inserting equations is available in Quick Parts. On the Insert tab, click Quick Parts and select the EQUATION block. The block contains a placeholder for the equation and a field with an automatic number.

	
	(1)


[bookmark: _Ref215418133][bookmark: _Ref215418139][bookmark: _Ref215418193][bookmark: _Ref215418197][bookmark: _Ref215418241][bookmark: _Ref215418245][bookmark: _Toc215419470]Cross-references
Cross-references provide a quick and easy way to navigate to a specific object in the electronic version of the thesis. References can be created for specific chapters, figures, charts, tables, equations, linguistic examples, and also for citation references (particularly useful when using the numeric citation style with square brackets). A cross-reference can be inserted via the Insert tab by clicking on Cross-reference (a similar procedure applies in Writer as well).
In the dialog box, you need to select the appropriate Reference type (e.g. chapter heading, figure, table, numbered list, etc.). Then, in the Insert reference to section, choose how the reference should appear (e.g. number, text, etc.).
[bookmark: _Ref215417865][bookmark: _Ref215417870][bookmark: _Ref215418257][bookmark: _Ref215418262][bookmark: _Toc215419471]Automatically Generated Lists
The template includes several automatically generated lists:
Table of Contents,
List of Figures,
List of Tables, and
List of Appendices included in the final thesis.
The Table of Contents is generated from the headings marked in Table 1. The List of Figures is generated from Figure captions. The List of Tables is generated from Table captions. The List of Appendices included in the final thesis is generated from the heading Appendix 1.
It is important to ensure that all these lists are updated before submitting or printing the thesis. More detailed information can be found in Chapter 2.4 Document Preview and Printing.
[bookmark: _Toc215419472]Updating the List of Appendices
When updating all automatically generated lists in Word, no issues should occur, and the lists as well as the table of contents should update correctly, regardless of the language version of the word processor or operating system.
The only exception is the list of appendices inserted in the final thesis. It may happen that, when updating the list of appendices, individual entries disappear and an error message appears instead – either “No table of contents entries found.” or its equivalent in the system language. This is caused by using the template in an environment where system, keyboard and MS Office interface language preferences differ (e.g. the user works with the English interface of Word or the entire Windows operating system).
The fix is simple: right-click the error message (it should be greyed out) and select “Toggle Field Codes”. Instead of the individual list entries, you will see a field code such as { TOC \n \h \z \t "Appendix 1;9" }. The issue is caused by the semicolon; it needs to be replaced with a comma, so the field code should read { TOC \n \h \z \t "Appendix 1,9" }. Then toggle the field codes again and update the table (right-click inside the field and select Update Field). After making this adjustment, the list of appendices should generate correctly.
[bookmark: _Toc215419473]Creating New Lists
If it is necessary to insert a new automatically generated list, the procedure in the respective word processors is as follows:
Word: Insert a new blank page after the lists of figures or tables (whichever is more appropriate) using the Ctrl + Enter shortcut. Then, using the Heading style, type the title of the list (e.g. List of Charts) and press Enter to move to a new line. On the References tab, click on Insert Table of Figures. In the dialogue box that appears, select the appropriate label in the Caption label dropdown menu for which the list should be generated (in this case, Chart). It is important that this caption has already been created and used in the thesis – the most commonly used caption labels should already be included in the template.
Writer: Insert a new blank page after the lists of figures or tables (whichever is more appropriate) using the Ctrl + Enter shortcut. From the Insert tab on the main menu, select Index and Tables, then choose either Table of Contents, Index or Bibliography, as required. In the Heading field, enter the title of the list (e.g. List of Charts). Under Type, select Table of Figures. In the Caption label dropdown, choose the relevant label for which you want to generate the list (in this case, Chart). It is important that the caption has already been created and used consistently throughout the document (the most commonly used captions should already be available in the template).
[bookmark: _Toc215419474]Removing Lists
If lists are to be removed from the thesis (as they are not a mandatory part of the thesis), it is recommended to first display all formatting marks (click the ¶ or use the Ctrl + Shift + 8 shortcut in Microsoft Word, or Ctrl + F10 in LibreOffice Writer). This helps prevent unintentional formatting issues across the document. The instructions for removing lists in different word processors are as follows:
Word: Display non-printing characters, then select the text from the heading of the list to the very last character on the page (in most cases, this will be a Page Break) and press the Delete key. For the list of appendices, only select the characters before the Section Break (Odd Page) – this break itself must not be selected. Then press Backspace repeatedly until the blank page is removed and the odd-page section is merged with the previous page.
Writer: Display non-printing characters and choose the appropriate method depending on the type of list. For the List of Figures and List of Tables, right-click anywhere inside the list and choose Delete Index. Then use the Delete key to remove the blank page. For the List of Abbreviations, select the text from the heading of the list to the last character on the page and press the Delete key twice to remove the blank page. For the Appendix List, use a combination of both methods: right-click in the list and choose Delete Index, then select the content from the heading Other Appendices to the last character and press Delete to remove it.
[bookmark: _Ref215409133][bookmark: _Toc215419475]List of References (Bibliography)
The citation of sources used in the thesis must follow the rules of the selected citation standard or referencing style. The reference list (or bibliography) must always be formatted in accordance with the chosen citation system used throughout the final thesis. 
The template includes two pre-defined paragraph styles for creating the list of references: Bibliography (alphabetical list) and Bibliography (numbered list). The appropriate style should be selected based on the referencing standard or style you are following (see Chapter 3.5 List of References (Bibliography) for more information on formatting styles). Both styles use visual emphasis of authors’ names by applying bold formatting. This formatting must be applied manually, and although it is not compulsory, it serves to highlight the authors within the list. However, if used, the formatting should be applied consistently throughout the entire list of references. 
[bookmark: _Toc215419476]General Principles for Creating Citations
According to the principles of information ethics, all sources used in the thesis must be properly cited. This applies to both direct quotations and paraphrased content. The purpose of citing sources is to enable the reader to identify and locate the materials the author has drawn upon.
1. Bibliographic details for citations must be taken directly from the cited source (i.e. the specific document that was consulted). The author must always cite the exact edition or version used.
1. Every citation must be clearly marked in the text (e.g. direct quotations are usually enclosed in quotation marks or presented in italics; paraphrased content is often separated into a new paragraph) and must be accompanied by a reference that links to the corresponding bibliographic entry in the reference list. The bibliographic citation must allow the cited source to be unambiguously identified.
1. The location of the citation within the cited document (i.e. the page number(s)) is mandatory for direct quotations. For paraphrased content, it is also recommended to include the relevant page range. It is not necessary to state the total number of pages of the source.
1. Citation details should primarily be taken from the title page of the source (or, in the case of digital or non-print media, from the home screen, web page, disc label, etc.). The order of the elements in the citation is defined by the chosen citation standard. Additional information may be taken from the verso of the title page, page headers, cover, packaging or accompanying documentation (e.g. leaflet, manual).
1. If certain information is missing from the source, it should be omitted and the citation should continue with the next available element. In some cases, missing details may be retrieved from alternative sources; if so, such information must be enclosed in square brackets.
1. All information in the bibliographic citation should be recorded in the language in which it appears in the original document. Only physical description elements (such as page count) and notes should be written in the language of the thesis.
1. The format of bibliographic citations must be consistent throughout the entire document – including citation style, formatting and punctuation.
1. If text is taken from a foreign-language source and used as a direct quotation in the thesis, it should be translated as accurately as possible. It is recommended to add a footnote stating that the translation is the author’s own, and to include the original text in the footnote as well.
[bookmark: _Toc215419477]Key Terms
Quotation (direct quotation) – a verbatim excerpt taken from another author’s work, which must be clearly distinguished from the author’s own text (typically using quotation marks). Even if the original text is only slightly modified – for example, by merging sentences or replacing a word – it is still considered a direct quotation. Direct quotations are commonly used for definitions. They should be kept concise and must be followed by an in-text citation referencing the source in the bibliography or list of references.
Paraphrase (indirect quotation) – the expression of someone else’s idea using the writer’s own words; a freely reformulated idea originally presented by another author. Paraphrased content is integrated into the main body of text without quotation marks. Although the length of a paraphrase is not restricted, the reader must be able to clearly identify where the paraphrase begins and ends. The original meaning and context must be preserved. Just like direct quotations, paraphrased material must be cited with a reference to the original source in the bibliography.
In-text citation – the method of linking a quotation (direct or paraphrased) to its corresponding bibliographic reference. It serves as a bridge between the main body of the text and the list of references. According to ČSN ISO 690:2022, there are three recognised citation methods: the author-date method, the numeric method and the footnote method. When using other citation standards or styles, it is essential to understand and adhere to the specific referencing rules of that style.
Bibliographic reference – a complete set of details about a cited source (text, image, chart, table, etc.) that enables the source to be clearly identified. A bibliographic reference (also referred to as a citation) must contain all the required and retrievable information. The formatting of the reference depends on the type of document being cited and the citation style used.
List of references / Bibliography – a compiled list of all documents and sources cited or consulted in the thesis. The list is formatted in accordance with the rules and requirements of the selected citation style or, where applicable, the specific method used within the given standard.
[bookmark: _Toc215419478]Appendices
Appendices are used for content that is not suitable to be included directly in the main body of the thesis. This typically includes more extensive visual materials, measurement results, questionnaires, source codes or more complex tables.
Appendices may form part of the thesis itself (in which case an automatically generated list of appendices is provided), or they may be submitted separately (in which case the list must be compiled manually).

[bookmark: _Toc215419479]Typographic Tool TeX/LaTeX
TeX is a specialised desktop publishing (DTP) software originally designed for typesetting mathematics. Today, however – particularly thanks to the LaTeX extension – it enables the creation of typographically high-quality output for any structured document, including final theses. 
A template is available for students of TBU in Zlín, which can be used by students from all faculties and is also available in an English version. It includes guidance and instructions on how to use it. The current version can be found on the university website in the section https://www.utb.cz/en/student-2/documents-and-templates.
It is expected that students interested in using the LaTeX template already have at least basic experience with the system or with programming in general. If not, it is recommended to first consult the relevant documentation.
[bookmark: _Toc215419480]Conclusion
It is always important to keep in mind that the template is merely a tool to help you achieve the final formatting of your thesis. Any inappropriate modifications to the text or the template itself may disrupt the overall appearance of the thesis or parts of it. That is why this manual is an essential and highly important part of the final thesis templates at TBU in Zlín. Please give it your full attention and keep it close at hand throughout the entire writing process.
None of us is perfect – and neither are the thesis templates. Although we have done our best to make the thesis-writing process as smooth as possible, we may have overlooked something. If you encounter any issues while working with the template and cannot find the answers in the manual, feel free to contact us at sluzby@k.utb.cz. We will be happy to look into it together and help you find a solution. 



[bookmark: _Toc215419481]Bibliography
The citation of information sources must follow the rules of a specific citation standard or style. The list of references must always be compiled in accordance with the chosen citation standard or style used in the thesis. For more information, see Chapter 4.6 List of References (Bibliography).


[bookmark: _Ref214295845][bookmark: _Ref214295850][bookmark: _Ref214295925][bookmark: _Ref214295933][bookmark: _Toc215419430]List of template styles
Styles used on the title page
Title page: title – used to format the main title of the thesis
Title page: author – used to format the author’s name
Title page: info – used to format the main details about the thesis (type of thesis, year of publication)
Title page: university – used to format the name of the university
Title page: faculty – used to format the name of the faculty

Heading styles (see Chapter 3.1 Headings)
Heading 1 – numbered first-level headings for the main chapters of the thesis; always begin on a new page and are included in the automatically generated table of contents
Heading 1 after divider – first-level headings for the main chapters that follow the Divider heading style in split templates (Word only)
Heading 2 – numbered second-level headings; included in the automatically generated table of contents
Heading 3 – numbered third-level headings; included in the automatically generated table of contents
Heading 4 – numbered fourth-level headings; not included in the automatically generated table of contents
Heading 5 – numbered fifth-level headings; not included in the automatically generated table of contents
Divider heading – alphabetical first-level headings used to visually divide the template into sections; always begin on a new page and are included in the automatically generated table of contents
Other headings – unnumbered headings for other parts of the thesis (abstract, declaration, etc.); not included in the automatically generated table of contents
Lists headings – unnumbered headings for lists (of figures, tables, etc.); included in the automatically generated table of contents
Headings for introduction + conclusion – unnumbered headings for the introduction and conclusion chapters; included in the automatically generated table of contents
Appendix 1, Appendix 2 – numbered first- and second-level headings for the appendices; first-level appendix headings are included in the automatically generated list of appendices



Styles for body text (see Chapter 3.3 Paragraphs)
Next paragraphs – style used for subsequent paragraphs of the text, with paragraph indentation and automatic hyphenation
First paragraph – style used for the first paragraph following a heading, figure, table or other inserted element, with automatic hyphenation
Other texts – for any additional body text in the thesis, with automatic hyphenation

Styles for special text types
Quote – see Chapter 3.6 Quotations and Poetry
Quote beginning – see Chapter 3.6 Quotations and Poetry
Quote continue – see Chapter 3.6 Quotations and Poetry
Quote end – see Chapter 3.6 Quotations and Poetry
Quote (USP-FHS) – see Chapter 3.6 Quotations and Poetry
Poetry – see Chapter 3.6 Quotations and Poetry 
Linguistic examples – see Chapter 3.7 Linguistic Examples
Linguistic numbered examples – see Chapter 3.7 Linguistic Examples
Equation – see Chapter 4.3 Equations
Source code – see Chapter 3.9 Source Code 
Source code without line numbers – see Chapter 3.9 Source Code

Styles for lists
Alphabetical list – see Chapter 3.4 Lists
List Number, Numbered list – see Chapter 3.4 Lists
List Bullet, Bulleted list – see Chapter 3.4 Lists
Multilevel list – see Chapter 3.4 Lists
Bibliography (alphabetical list) – see Chapter 3.5 List of References (Bibliography)
Bibliography (numbered list) – see Chapter 3.5 List of References (Bibliography)
Styles for captions
Caption – for captions of figures or charts
Figure caption with source – for figure or chart captions used in combination with the Figure/table source style
Table caption – for captions of tables 
Caption source code – for captions of code listings
Figure/table source – style for citing the source of a figure or table (placed on a new line)

[bookmark: _Toc215419431]List of Quick Parts and Building Blocks
Quick Parts contain pre-prepared special blocks in Word designed to make working with the template easier. These Quick Parts are available only in the Word version of the template. They are part of the template itself and are not transferred to documents that are based on the template. Therefore, the thesis document must remain connected to the template throughout the entire writing process. If the document is not connected to the template, the Quick Parts will not be available. 

FIGURE caption below – a building block for inserting a figure with a caption placed below
FIGURE with source – a building block for inserting a figure with a caption and source (source appears on a new line below the caption)
EQUATION – a building block for inserting an equation
TABLE caption above – a building block for inserting a table caption placed above the table

Name of sample chart

Series 1	Category 1	Category 2	Category 3	Category 4	4.3	2.5	3.5	4.5	Series 2	Category 1	Category 2	Category 3	Category 4	2.4	4.4000000000000004	1.8	2.8	Series 3	Category 1	Category 2	Category 3	Category 4	2	2	3	5	
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1 Heading following section heading

It is possible to use this template in both divided and undivided forms. The undivided
template does not use division and starts with the main heading (style Heading 1). The
divided template uses the first-level Divider heading, which ensures visual division into
individual parts, e.g, A THEORETICAL PART, B PRACTICAL PART. The Divider
heading style always starts on a new page and uses alphabetical marking. This heading is
followed by the Heading 1 after divider style, which uses the same properties as the parent
Heading 1, but does not start on a new page. Please check what type of template your faculty
or department uses and choose the style for the heading on this page accordingly (the default
setting is Heading 1). For a divided template, use the Divider heading style and write the
title of the given partin capital letters. Please read the instructions in the manual. Click here
and press DELETE to delete the box. Then press ENTER to end the heading.

Tt is possible to use this template in both divided and undivided forms. The undivided
template does not use division and starts with the main heading (style Heading 1). The
divided template uses the first-level Divider heading, which ensures visual division into
individual parts, e.g, A THEORETICAL PART, B PRACTICAL PART. The Divider
heading style always starts on a new page and uses alphabetical marking. This heading is
followed by the Heading 1 after divider style, which uses the same properties as the parent
Heading 1, but does not start on a new page. Please check what type of template your faculty
or department uses and choose the style for the heading on this page accordingly (the default
setting is Heading 1). For a divided template, use the Divider heading style and write the
title of the given partin capital letters. Please read the instructions in the manual. Click here
and press DELETE to delete the box. Then press ENTER to end the heading
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1 Chapter following the section heading

It is possible to use this template in both divided and undivided forms. The undivided
template does not use division and starts with the main heading (style Heading 1). The
divided template uses the first-level Divider heading, which ensures visual division into
individual parts, e.g., A THEORETICAL PART, B PRACTICAL PART. The Divider
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